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To fill in the blanks

1. Click on the blank you want to fill.

2. Type the value you want to have in the 
blank. If it’s a blank that requires numbers, 
you will only be allowed to enter numbers.

3. You can use the tab key to move to the next 
blank, or the shift-tab keys to move to the 
previous blank.

4. When finished editing blanks, you can click 
any place on the card to finish.

 
Figure 22b. Filling in blanks

To select an option from a drop-down

1. Click on the underlined word  
you want to change.

2. A box will appear around the word 
with an arrow on the right.

3. Click on the arrow to display a 
drop-down list of choices.

4. Use the up and down arrow  
keys or the mouse to make  
your selection from the list.

5. You can use the tab or shift-tab keys 
to move between the blanks and 
drop-downs.

 
Figure 22c. Choosing from a drop-down list
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To edit the exercise titles or captions

1. Double-click anywhere in the title or 
caption. A box will appear around the 
text. If there are more lines of text than 
can fit in the box, scrollbars will appear  
on the right side of the box.

2. Make any desired changes to the text. You 
can add, delete or change the text 
in any way you want.

3. When you are finished, click anywhere 
outside the box.

4. You can edit the text as many times  
as you want by simply  
repeating steps 1 through 3.

Figure 22d. Editing titles and captions

To remove the exercise title or captions

• To remove all card text and show just the picture, click the Eliminate All Text box.

• To remove the card’s title, click the Eliminate Card Title box.

• To restore the title, the captions, or both,  
deselect the appropriate box by clicking on it again.

Figure 22e. Eliminating text and/or titles
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To select a gender from within the Edit Exercise dialog

• Many of the VHI exercise kits contain both male & female images.

• The gender of the exercise image can be selected by clicking the gender button at the bottom of 
the Edit Exercise dialog box. See Figure 22a.

• If the gender button is not available, the current kit does not include male and female images.

To select a language from the Edit Exercise dialog

• Many of the VHI exercise collections contain multiple languages for the captions. 

• To change the language of the exercise text, choose the language from the Language menu at 
the top of the Edit Exercise dialog.

• NOTE: If you’ve made any changes to the text, they will be discarded when changing languages in 
the Edit Exercise dialog.

Figure 22f. Selecting a language
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CUSTOMIZED CARDS

VHI PC-Kits allows you to save the changes you have made to cards so that you will not have to redo them 
each time you use the card.

• Each therapist can have his or her own customized cards.

• The Administrator can create customized cards that are usable by all therapists.  
This can be used as a tool to standardize care.

• You can make a customized card the default for a given exercise.

• The available customized versions of an exercise card are available through the  
Edit Exercise dialog and through the Customized Card Viewer.

For more information on Customized Cards, see Customized Cards in the Advanced Topics section of 
this manual.
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BOOKMARKS

VHI PC-Kits allows each therapist to bookmark commonly used exercises. Using the View Bookmarks 
dialog, you can quickly recall exercises that you frequently use.

• Each therapist can have his or her own collection of bookmarks.

• There is no limit to the number of cards you can bookmark. When you bookmark cards, you 
can assign your own name to the bookmark for easy identification.

For more information on Bookmarks, see Bookmarks in the Advanced Topics section of this manual.

PREVIEWING A ROUTINE
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Before printing, e-mailing, or exporting your routine, you can preview it to see if you want to make 
changes.

 
Figure 26a. Print Preview

To preview a routine from the main menu
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1. From the File menu select Print Preview. The Printing Options dialog will appear.

2. Choose any printing options you would like. For more information on this,  
see Printing a Routine below.

3. After selecting your options, click the OK button.

4. Your routine will be displayed, as it will be printed.

 
Figure 26b. Print Preview toolbar

To preview a routine from the context-sensitive menu

1. Right-click on the routine in the Routine Window.

2. Select Print from the menu. The Printing Options dialog will appear.

3. Choose the printing options you would like. For more information ,  
see Printing a Routine.

4. After selecting your options, click the Preview button.

5. Your routine will be displayed, as it will be printed.

Other options available while previewing a routine

• You can use the tabs at the top to view the various pages of the printout.

• You can right-click to zoom in and out.

• If you want to modify your printing options, press the Modify button on the toolbar at any 
time.

• You can also print, e-mail or export your routine from the File menu or using buttons on the 
toolbar.

• If you want to change the cards on the routine, exit from preview (using the Exit Preview 
button) and edit your routine as desired.
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PRINTING A ROUTINE

There are multiple ways to print an exercise routine. You can 
select Print from the File menu, use the print button on the 
toolbar or right-click on the routine and select print from the 
context-sensitive menu.

Figure 27. Printing from the main menu

Regardless of how you start the printing process, you will be 
presented with the Printing Options dialog. This dialog allows 
you to specify which types of printouts you want and their 
format.

There are three types of printouts available from VHI PC-Kits:

• Exercise Routine – This is a printout  
of the routine as you created it.

• Chart Copy – This is a condensed version 
of the printout that is more suitable for 
storage in a patient’s chart.

• Tracking Grid – This printout is for the 
patient to record the details about his 
or her exercise sessions for tracking and 
record keeping purposes.

 

Figure 28. Printing Options dialog
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For each type of printout you choose, a tab will be added to the Printing Options dialog. On the added tab 
will be options which can be used to customize the printout. For example, if you choose to print a tracking 
grid, tabs for tracking grid options will appear in the Printing Options dialog.

 
Figure 29. Printing Options tabs for Tracking Grids

General Options

From the General Options tab, you can specify which types of printouts you want to produce.  
In addition, you can specify the following to be printed in the header of the routine,

• The name of the patient or client the routine was created for. You can supply a name to be 
printed on the routine without having to save the routine in the patient’s history. For more 
information on saving a routine in a patient’s history, see Saving Exercise Routines.

• The name of the therapist or person creating the routine.

• The title of the routine.

• A clinic or company logo to be printed on the routine. For more information on importing 
logos, see Adding Logos.

All of this information is optional.
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PRINTING TRACKING GRIDS

In addition to printing the exercise routine, you can also choose to print a tracking grid. A tracking grid is 
a printout that contains thumbnail images of the exercises and provides a grid where the patient can record 
their exercise sessions.

The tracking grids are highly customizable. Some of the things you can customize on a tracking grid are,

• There are two types of tracking grids, one designed to record a single day’s activity per page 
and one designed to record a week or more of activity per page.

• How often or on which days of the week the patient should be performing  
the exercise routine.

• What type of information the patient should be recording  
(e.g. Set, Reps, Weight, etc.)

For more information on customizing tracking grids, press the Help button on the Printing Options 
dialog.

To print a basic Tracking Grid

1. From the File menu choose Print.

2. In the Printing Options dialog, click on the Tracking Grid checkbox.  
Two more tabs will appear for you to specify the tracking grid options.

3. If the only printout you want to produce is the tracking grid, make sure  
all other printout types are unchecked.

4. You can customize the type of tracking grid and other options via the  
Tracking Grid and Advanced Tracking Grid tabs.

5. Click OK to print the tracking grid.

 
Figure 30. Selecting to print a Tracking Grid

NOTE: You can use the Preview button on the Printing Options dialog to preview your 
tracking grid, just as you would preview a routine.
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PRINTING A CHART COPY

Exercise routines can be printed in a condensed form for storage in a patient’s file. This condensed form 
contains 12 exercises per page and is referred to as a chart copy. You can print a chart copy at the same 
time that you print the routine for the patient, or you can print it separately.

To print a Chart Copy

1. From the File menu choose Print.

2. In the Printing Options dialog, click on the Chart Copy checkbox.  
The Chart Copy tab will appear in the Printing Options dialog box.

3. If the only printout you want to produce is the chart copy, make sure  
all other printout types are unchecked.

4. You can optionally add comments to the printout by supplying them  
in the Chart Copy tab.

5. Click OK to print the chart copy.

  
Figure 31. Selecting to print a Chart Copy

NOTE: You can use the Preview button on the Printing Options dialog to preview the 
chart copy, just as you would preview a routine.
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SAVING EXERCISE ROUTINES

There are two ways to save routines in VHI PC-Kits,

• Saved Routine – You can save a frequently used routine as a saved routine.  
You can then reuse the routine whenever you like.

• Patient History – You can keep a record of the routines you have given to  
patients that you create in VHI PC-Kits. 

If you are signed into VHI PC-Kits as the administrator, then any saved routine you create will  
be visible to all therapists. This allows you to set standards throughout your organization.

To save a routine as a new Saved Routine

1. Once you have created an exercise 
routine, you can save it as a saved 
routine by clicking on the save button 
on the toolbar, by selecting Save 
As from the File menu or by right-
clicking the routine and selecting  
Save As.

2. The Save Routine dialog will  
appear. Select Save as a New  
Saved Routine and click OK.

Figure 37. Save Routine dialog

3. The Saved Routine Properties dialog will 
appear. You should give your routine 
a name and supply an optional set of 
comments. These comments are only seen 
by the therapist when viewing the saved 
routines and are not printed on patient 
copies.

4. Click OK to complete the process.

Figure 38. Saved Routine Properties dialog
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To save a routine for a new patient

1. Once you have created an exercise routine, you can save it for a new patient by clicking on the 
save button on the toolbar, by selecting Save As from the File menu, or by right-clicking the 
routine and selecting  
Save As.

2. The Save Routine dialog  
will appear. Select Save  
in a New Patient’s History  
and click OK.

3. The Patient Properties 
dialog will appear. Enter  
the patient information  
and click OK.

Figure 39. Patient Properties dialog

4. Next the Patient History 
dialog will appear. You can 
give this routine a title and 
description if you like, but it 
is not required. When you’re 
done, click OK. The title and 
comments become part of the 
patient history but are not 
printed on routines you give 
to the patient.

Figure 40. Patient History dialog
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To save a routine for an existing patient

1. Once you have created an exercise routine, you can save it as a saved routine by clicking on the 
save button on the toolbar, by selecting Save As from the File menu or by right-clicking the 
routine and selecting Save As.

2. The Save Routine dialog will appear. Select Save in an Existing Patient’s History and click OK.

3. The Select Patient dialog will 
appear. Find the desired patient  
and select it. Click OK.

Figure 41. Select Patient dialog

4. Next the Patient History 
dialog will appear. You can 
give this routine a title and 
description if you like, but it 
is not required. When you’re 
done, click OK. The title and 
comments become part of the 
patient history but are not 
printed on routines you give to 
the patient.

For more information on how to view and edit Patient Histories and Saved Routines, see Editing Patient 
History and Saved Routines in the Advanced Topics Section.
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CHIROPRACTIC TREATMENTS MENU

When the Chiropractic Rehabilitation kit is installed in 
VHI PC-Kits, a special Treatments menu appears in the 
Main Menu. This treatments menu allows you to see the 
Chiropractic Rehabilitation Kit organized by treatments 
and conditions. This menu is only available when the 
Chiropractic Rehabilitation kit is installed.

Figure 41a. Chiropractic “Treatments” menu

For example, to see which exercises are 
suggested for Cervical Spine, Hypolordosis, 
you would select Cervical Spine and 
Biomechanics from the Treatments menu. 
Clicking the Hypolordosis tab would show 
you those suggested exercises.

Figure 41b. Viewing suggested Hypolordosis exercises

When using the Treatments menu, 
please note the following:

• The treatments menu contains 
only those exercises that are in the 
Chiropractic Rehabilitation kit. 
Exercises from other kits that you 
may have purchased and installed 
will not be included in the suggested 
exercises.

• To return to viewing the entire 
Chiropractic Rehabilitation kit, 
reselect it using the Kits menu.

• The suggested exercises are futher 
classified by treatment stage (Initial, 
Intermediate and Advanced). To 
select a treatment stage, use the 
category drop-down list as shown 
in figure 41c.

Figure 41c. Selecting treatment stage
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ADVANCED TOPICS

EDITING CARDS IN SPLIT LAYOUT

The split layout is chosen through the Layout menu, either from the main menu or by right-clicking on 
the exercise routine. Unlike regular layouts where the text is formatted around the exercise image, the split 
layout places the images in a column down the left side of the routine and the text in a column down the 
right. This permits the following,

• There’s more room for text on the card. Hence you should use the split layout if you’re going to 
be adding a lot of additional instructions to the card.

• You can flip the orientation of the image. So if you want to make the image right or left 
handed, you should use the split layout.

When editing an exercise for a split layout, the Edit Exercise dialog has two tabs. The first tab shows you 
the exercise image and allows you to reverse its orientation. The second tab gives you space to edit the text 
of the card.

 
Figure 42. Edit Exercise dialog

Editing the text in the Edit Text tab is the same as editing text on a normal card. You can fill out the 
blanks by clicking on them, or you can edit the text in its entirety by double-clicking on the paragraph 
you wish to edit.

NOTE: Flipping the exercise’s image is only available in split layouts. Therefore if you flip the image and then 
change the layout of your routine back to one of the regular layouts, the orientation will revert back to the default 
for that exercise.
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SPECIAL CARDS

Each kit contains a tab labeled Special Cards. Contained in this section are cards that are generally 
applicable to every kit. Currently, the following two cards are in every special cards section,

• Office Card – This card contains your office information such as address and phone number. 
You can also add comments to this card.

• Blank Card – This card had no picture. You can 
use this card to write additional directions or 
comments to the patient. Figure 43a. Special Cards tab

Using the Office Card

Before you can use the office card, you’ll need to supply your office information. You only need to do this 
once. VHI PC-Kits will remember the information you provide.

To supply your office information

1. In the main menu, choose 
Settings from the File menu.

2. The Program Settings 
dialog will appear. Click  
on the Office tab.

3. Fill in any of the information 
you want and then click OK.

Alternatively, the program will ask you 
to supply this information the first time 
you try to use an office card.

Figure 43b. The Program Settings dialog with the Office tab

To add an Office Card to your routine

1. Click on the Special Cards tab in the exercise browser and use the Office Card just as you 
would any other exercise card.

2. A special Edit Exercise dialog appears. In this dialog, check any information  
you want to show on the office card and add any comments you want to make.

3. Click on Place Card to put the office card in the routine.
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Using Blank Cards

The Blank Card is useful for adding more instructions or comments to the exercise routine. Just like any 
other card, you can save text that you put on a blank card as a customized card. For more information see 
Customized Cards.

To add a Blank Card to your routine

1. Click on the Special Cards tab in the exercise browser and  
use the Blank Card just as you would any other exercise card.

2. Using the Edit Exercise dialog, enter comments or instructions  
in the space provided.

3. Click on Place Card to put the card in your routine.
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CUSTOMIZED CARDS

Changes you make to exercise cards, including modifications to the text or filling in the blanks, can be 
saved as customized version of the card. That way, you do not need to redo the changes each time you use 
the card. You can save as many customized versions of a card, as you like.

The customized versions of the card are associated with the original card. That is, to access the customized 
versions of a card, you simply bring up the original card and select which version you want to use. There’s 
also a Customized Card Viewer which will show you all your customized cards in one place. For more 
information on the viewer, see Customized Cards in the Advanced Topics section.

Customized cards, like other information in PC-Kits are private to the therapist that created them. Only 
the therapist who created a card is able to use it. The exception to this rule is customized cards created by 
the Administrator user. These customized versions are usable by all therapists, which provides a way to 
standardize exercise variations throughout your clinic.

Just like the original card, bookmarks can be placed on customized versions of cards. Bookmarking a 
customized card provides a quick and easy way to recall the card for later use. For more information on 
bookmarks and bookmarking customized cards, see Bookmarks in the Advanced Topics section.

To create a Customized Card

1. Select and edit the desired exercise. This can be a 
normal exercise or any of the Special Cards including 
the Blank Card.

2. After modifying the card, select Save as Customized 
Card from the Customized Cards menu in the Edit 
Exercise dialog.

Figure 45a. The Customized Cards menu

u

3. The Create Customized Card dialog will appear; give 
the card a name to help you identify it and click Save. 
This name is not printed on the card, it’s just for your 
reference.

4. The name of the card you just created will 
now appear in the Customized Cards drop-
down list.

Figure 45b. The Create Customized Card dialog
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To use a Customized Card

1. In the exercise browser, double-click on the original exercise to bring up the Edit Exercise 
dialog.

2. If any customized cards exist for the exercise, a dropdown list of their names will appear at the 
top of the dialog.

3. Click on the arrow to the right of the list to see the available  
customized versions of this card.

4. From the list, select the customized version you want to use.

5. Click Place Card to add the card to the routine.

 
Figure 45c. Edit Exercise dialog with drop-down list of Customized Cards
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To modify an existing Customized Card

1. Follow the procedure above for Using a Customized Card to select  
the Customized Card you want to modify.

2. Make the desired changes.

3. When editing is completed, select Customized Cards from the Edit Exercise dialog box 
menu, then select Save Modifications. Remember, this card will replace the customized  
card you modified.

To change the name of an existing Customized Card

1. Follow the procedure above for Using a Customized Card to select  
the customized card you want to modify.

2. From the Customized Cards menu, select Properties.

3. Make the desired changes and click Save.

It is also possible to make a customized card the default card which is then used when choosing a card.

To make a customized version the default version

1. Follow the procedure above for Using a Customized Card to select the  
customized card you want to make default.

2. From the Customized Cards menu, select Make Default.

3. The name of the customized card moves to the top of the list, followed by “(default)”.  
Follow these same steps to change the default to any other custom card.

To set the default back to the original card

a. In the exercise browser, double-click on the card you wish to change.

b. When the Edit Exercise dialog appears, select Clear Default  
from the Customized Cards menu.

c. The original card will now be used by default.
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Viewing all the Customized Cards

Normally, customized versions of cards are accessible through the Edit Exercise dialog when placing a card 
in a routine. You may also use the Custom Card Viewer to view all your custom cards in one place.

To view all of your customized cards

1. From the Cards menu, select View Customized Cards.

2. The View Customized Cards dialog box will appear.

 
Figure 46. The View Customized Cards dialog

3. From this dialog you can use the card (i.e. place it in the routine), view a card,  
delete a card, or find the card (i.e. which kit and section it’s from).

NOTE: You can view all your Customized Cards at one time or by individual Kits 
or by sections of individual kits.
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BOOKMARKS

Bookmarks give you fast access to the exercises you use frequently. By using bookmarks, you can jump 
rapidly to any exercise that you have marked. You can place bookmarks on,

• Any card in any exercise kit.

• Any custom version of an exercise card.

• Any language version of an exercise card.

Bookmarks are separated by therapist, so each therapist sees only his or her own bookmarks.

To create a bookmark you can do any of the following

• Select an exercise in the exercise browser, then click the paperclip icon at the lower right-hand 
corner of the exercise browser.

• Double-click on an exercise to pull up the Edit Exercise dialog. From the menu in the Edit 
Exercise dialog, select Bookmarks and then Set Bookmark. You may also click on the 
paperclip icon in the lower corner of this dialog.

• Right-click the desired exercise in the exercise browser. Select Set Bookmark from the context-
sensitive menu. 

Any of these four ways of bookmarking the exercise 
will cause the Set Bookmark dialog to appear. 
This dialog is used to name your bookmark. By 
default, the title of the card is used. You can name 
your bookmark any way you like.

  

Figure 47. Set Bookmark dialog

To bookmark a Customized Card

1. Bring up the customized card in the Exercise Edit dialog by double-clicking  
the exercise and selecting the customized version you want to bookmark.

2. Bookmark the card using either the Bookmarks menu of the Edit Exercise dialog  
or the paperclip icon in the lower right corner.
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Viewing and using bookmarks

From the main menu, select Bookmarks and then View Bookmarks. This displays the View Bookmarks 
dialog, which lists all the bookmarks created and saved by the therapist.

 
Figure 48. View Bookmarks Dialog

To narrow the range of bookmarks to view, you can select a specific kit and section using the drop-down 
list boxes at the top of the View Bookmarks dialog.

From the bookmark dialog, you can place a bookmarked card in the routine by selecting the exercise and 
clicking the Use Exercise button. You can find which kit and section an exercise came from by selecting 
the exercise and clicking the Go to Exercise button. This moves you quickly to the kit and section that 
contains the exercise.

Modifying a bookmark

To change the name of a bookmark 

1. Select the one you want to change from the list in the View Bookmarks dialog box.

2. Click the Modify button. The Bookmark Properties dialog will appear. Supply the new 
name for the bookmark and click Set.

 
Figure 49. Bookmark Properties dialog
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EDITING AN EXERCISE ROUTINE

VHI PC-Kits features great flexibility in allowing you to revise and modify exercise routines.

To add a page to a routine do one of the following

• Click on the New Page Tab located at the top of the routine.

• Right-click on any image on the routine window and select  
Add Page from the context-sensitive menu.

To delete a page from a routine

1. Click on the tab of the page to be deleted so it is highlighted.

2. Place pointer over routine window and right-click. From the context-sensitive menu,  
click on Delete Page, and the displayed page will be deleted.

To move exercises

1. Place your pointer on the exercise you want to move.

2. Click and drag the exercise to the desired location on the same page.

3. Release the mouse button.

To swap exercises

1. Place your pointer on one of the exercises you want to swap.

2. Click and drag the exercise over the other exercise you want to swap.

3. Release the mouse button, select Swap from the Move Exercise dialog.

 
Figure 50. Move Exercise dialog
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To overwrite exercises

1. Click and drag the exercise over the exercise you want to overwrite. 

2. Release the button and select Overwrite from the Move Exercise dialog.

To move an exercise to a different page

1. Create a new page if needed by clicking the New Page tab.

2.Return to the appropriate page and place your pointer on the exercise  
you want to move.

3. Click and Drag the exercise to the page tab for the page on which you  
want the exercise to be placed.

To move multiple exercises to a different Page

1. Hold down the Ctrl Key and click on each exercise you want to move.

2. When clicking on the last exercise you want to include in the move,  
keep the mouse button depressed but release the Ctrl Key.

3. Drag your pointer to the page tab where you want to place the exercises.

4. Release the mouse button.

To copy an exercise to another page

1. Hold down the Ctrl Key.

2. Click and drag the exercise you want to copy to the page tab  
where you want it to go. 

3. Release the mouse button.

To copy multiple exercises to another page

1. Hold down the Ctrl Key.

2. Click on each exercise you want to copy. When clicking the last exercise,  
keep the mouse button AND the Ctrl Key depressed.

3. Drag pointer to the page tab where you want to copy the exercises.

4. Release the mouse button then the Ctrl Key. 
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To editing an exercise in an existing routine

1. In the Routine Window, place your pointer on the exercise you want to edit  
and double-click.

2. The Edit Exercise dialog appears.

3. Follow the usual editing procedures and, when completed, click Place Card.

To delete an exercise from a routine

1. Right-click the exercise you want to delete.

2. Select Delete from the context-sensitive menu.  
 
OR

1. Select the exercise you want to delete by clicking on it.

2. From the Edit menu in the main menu, select Delete. 
 
OR

1. Click on the exercise.

2. Press the delete key on the keyboard.

To move pages within a routine

1. Click the left mouse button on the tab of the page being moved at the top of the Routine 
Window and hold the mouse button down.

2. Drag the mouse over the tab where you want to place the page being moved.

3. Release the left mouse button.

4. The page you clicked on will now be placed where your released 
the mouse button. The other pages will be shifted left or right.

You can alternatively right-click on a tab and move the page one place left 
or right using the context sensitive menu. See Figure 50a.

Figure 50a. Moving a page right
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Changing the layout of a routine

The layout of a page in an exercise routine, refers to the number of cards on that page. Each page in a routine 
can have a different layout, if so desired. Whether a page prints in landscape or portrait is a function of the 
layout used and cannot be changed separate from changing the layout.

By default, new pages are created with six exercises per page. If you want to change the default,  
you can do so via the General tab in the Settings dialog. See Program Settings for more details.

To select a page layout from the Routine Layout toolbar

1. Use the tabs at the top of the Routine Window to display the desired page.

2. At the bottom of the Routine Window is a toolbar for changing the layout of the current page.

3. Place the mouse over the icon representing the layout you want to use.

4. Click the button and the layout for the currently displayed page will be changed.

Figure 50b. Routine layout toolbar

You may also use the Layout menu in the main menu or the context sensitive (right-click) menu to change 
the current page’s layout. To go back to the previous layout, use the Undo toolbar button. If you are trying 
to decide which looks best, you can click back and forth on undo and redo.

Please note the following when changing layouts,

• If there are fewer exercises per page on the new layout, PC-Kits will automatically add enough 
pages to hold all the exercises in the routine.

• If the routine has multiple pages, and you change the layout to get more exercises per page, 
PC-Kits will NOT move exercises from page to page. You must move the exercises manually.

• Changing from a Split Layout to any of the other layouts may exceed that layout’s text capacity. 
If this happens, the layout will not display any text beyond its maximum. You do not lose the 
text; it just doesn’t display. You can regain the text by switching back to a Split Layout. There 
is a warning message to alert you of this.

 
Figure 51. Split layout text warning box
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EDITING PATIENT HISTORY

With VHI PC-Kits you can store routines you create for patients in the patient’s history. These routines 
can be later viewed and/or edited for reuse.

To view your Patient Histories

1. Select Patients from the main menu, and then select Browse Patient Histories. The Patient 
Histories window will appear.

2. Click the Show All Your Patients box, midway down on the left, to display the full list of your 
saved patient histories. Alternatively type the desired patient’s last name in the box provided. 
As you type, names appear in the list. When the name of the patient you want appears, stop 
typing.

3. Highlight the desired patient name to display a list of the routines that have been created and 
saved for that patient.

4. Highlight the routine you want. At the bottom on the left show any comments attached to the 
routine. The selected routine is shown on the right. 

 

Figure 52a. Patient Histories
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Editing patient information

1. Go to the patient histories window as described above.

2. Double-click on the patient name. A Patient Properties dialog box appears. Alternatively, 
right-click the patient name and click on Properties.

3. Change or edit information in this dialog box. When you’re done, click OK to save your 
changes.

Reusing routines in Patient Histories

Any of the routines you’ve previously saved for a patient can be edited and reused.

To edit and reuse a patient routine

1. While viewing your patient histories, as described above,  
select a routine you want to reuse.

2. Click on the Reuse Routine tab. This will take you out of patient histories  
so that you can edit the routine.

3. When you’ve made any desired changes to the routine,  
click the Save toolbar button, or select Save As  
from the File menu.

Figure 52b. The Reuse Routine tab

Editing Patient History routine title and comments

Each routine saved in a patient’s history can have an optional title and comments. This information is first 
supplied when the routine is saved, but can be edited or added later.

To modify a routine’s title or comments 

1. While viewing your patient histories, as described above, select a routine for which you want to 
edit the title or comments.

2. Right-click on the routine and select Properties.

3. Edit the title or the comments as desired.

4. Click the OK button.
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Printing patient routine comments

As described previously, you can enter comments for each routine saved in a patient’s history. The history 
of comments made for a particular patient can be printed on a single printout.

To print a history of a patient’s comments

1. While viewing your patient histories,  
as described above, select a patient for  
which you want to print a comment history.

2. Right-click on the desired patient.

3. From the menu, select Print Comments.

Figure 52c. The Print Comments menu item

Finding a card on a routine

Sometimes when browsing through the routines in the 
patient histories, you will come across a card that you want 
to know which kit and section it came from. VHI PC-Kits 
makes this easy.

To find where a card came from

1. While viewing your patient histories, as described above,  
select a routine for which you want to find a card.

2. Click on the Reuse Routine tab.

3. Right-click on the card you want to find and select the Find 
Card item from the menu.

4. The exercise browser will jump to that routine, showing you 
which kit and section the exercise is found in.

NOTE: This feature is available for all cards in all types of routines, 
not just cards on patient routines. It can be used any time you see a 
card in a routine and would like to know which kit it came from.

 Figure 52d. The Find Card menu item
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SAVED ROUTINES

Saved routines are routines that you use commonly and wish to recall frequently. Each therapist can have 
their own saved routines, or the Administrator can create common saved routines visible to all therapists.

NOTE: Saved routines differ from patient history routines in that they are not tied to a particular patient. 
To save a history of routines given to a patient, use patient histories instead. For more information on patient 
histories, see Patient Histories.

To view your saved routines

1. From the Routines menu select Browse Saved Routines.

2. Your saved routines will be listed by name on the left side of the screen with the selected 
routine appearing on the right.

3. You can use the scroll bar to look through all the available routines.

4. Right-clicking on a routine will present a menu of options that allow you to,

• Delete a Routine

• Edit/Reuse a Routine

• Print a Routine

• Edit the Routine’s Properties

To modify an existing saved routine

1. While browsing your saved routines, as described above, select the routine you  
want to edit.

2. If you want to simply modify the name of the routine, right-click on the routine title and select 
Properties. Otherwise, click on the Edit/Reuse Routine tab.

3. You will now be put back in the exercise browser where you can edit the routine.

4. Make any desired changes to the routine.

5. Click the Save toolbar button, or select Save As from the File menu.

6. If you want to overwrite (replace) the existing routine, choose Update Current Saved 
Routine with Changes. If you want to keep the original routine and save the edited routine 
under a different name, choose Save as a New Saved Routine. Click OK after making your 
selection.
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To use a saved routine for a patient

1. While browsing your saved routines, as described above, select the routine you want to use.

2. If you simply want to print the routine, you can print it from the File menu.  
You can also save it in a patient’s history using the Save As menu item in the File menu. If you 
want to modify the routine first, click on the Edit/Reuse tab.

3. You will now be put back in the exercise browser where you can edit the routine.

4. Make any desired changes to the routine.

5. You may now print it or save it using the Save As menu item in the File menu.

Copying a Saved Routine from one therapist to another

VHI PC-Kits facilitates sharing of saved routines between therapists in two ways. First, the Administrator 
therapist can create saved routines. Any routines created in this way will be visible to all therapists. Secondly, 
you can copy your saved routine to another therapist.

To copy a routine to another therapist

Figure 53. Saving a routine under another therapist

1. While browsing your saved routines, as 
described above, select the routine you 
want to save to another therapist.

2. Right-click on the routine and choose 
Save As from the menu.

3. The Save Routine As dialog appears. 
Fill in the dialog box, giving the 
routine a title and optional comments if 
desired.

4. In the Save Under drop-down list, 
select the therapist to which you want 
to save the routine.

5. Click the save button. The therapist selected in the previous step will now be able to use and 
edit the routine.

NOTE: This makes a new copy of the routine for the target therapist. Any changes made by that 
therapist will not change your original copy of the routine.

t
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ADMINISTRATOR AND THERAPIST FEATURES

VHI PC-Kits can be configured such that each user, or therapist, can have his or her own Sign In. The 
data created by each therapist is then stored separately from other therapists. By default, VHI PC-Kits is 
configured to separate data by therapist Sign In. This can be enabled and disabled via the Settings item 
of the File menu.

When therapist Sign Ins are enabled, there’s a special therapist Sign In called the Administrator. The 
Administrator has access to all information created by other therapists (except their bookmarks and custom 
cards). The administrator is also the only user who is allowed to change most program configuration 
information.

In addition to these special functions, the administrator also serves another purpose. The administrator can 
create saved routines and custom cards that are visible to every other therapist using VHI PC-Kits. This 
allows a clinic to create standardized routines and cards that everyone else can view and use. Remember 
that any patients, saved routines, custom cards, bookmarks, etc. that are created by individual therapists 
are only visible and usable by that therapist.

There are four different modes in which the program can operate. These modes are,

• There is no therapist Sign In and hence no separation of data by therapist.

• Therapists sign in by selecting their  
name from a list. There is no  
password protection of therapist data.

• Therapists sign in by supplying a  
username and password.  
Each therapist’s data is therefore  
protected from others seeing it.  
Only the Administrator can see  
other therapist’s data.

• Therapists sign in using Integrated  
Windows Authentication. In this  
mode, data is separated by  
therapist, but which therapist  
is signed in is determined by who’s  
signed into the workstation.

 
Figure 54a. Settings for switching therapist Sign In modes
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Creating a therapist without passwords enabled

In this mode, therapists are created directly from the sign in screen or by 
using the Create Therapist item in the Therapists menu. Anyone can 
create a therapist in this mode.

Figure 54b. Create Therapist menu item

Creating a therapist while passwords are enabled

If passwords have been enabled, only the Administrator is allowed to create therapists. In addition, each 
therapist must be assigned a username and password when they’re created. The therapist can then change 
their password at any time. For more information on enabling password protection, see the section titled, 
Enabling Password Protection later in this manual.

To add a therapist while passwords are enabled

1. Sign in to the program as the Administrator.

2. Select Create Therapist from the Therapists menu. The Therapist Properties dialog will 
appear.

3. You must supply a first and last name as well as a username. The e-mail address is optional. 
The password field is required if you don’t want to allow blank passwords. 

NOTE: When you enabled username sign in for therapists, you could choose to allow or disallow 
blank passwords. If blank passwords are enabled, then you are not required to supply a password 
when creating a therapist. However this also means that a therapist can sign in using only their 
username.

 
Figure 54c. Therapists Properties dialog
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Modifying a therapist

The Administrator is allowed to modify any therapist in the system. Otherwise, a therapist is only allowed 
to modify his or her own properties.

For a therapist to modify their own properties,

1. Sign in as the therapist to be modified.

2. Select Modify Therapist from the Therapist menu. The Therapist Properties dialog  
will be presented.

3. Depending on whether username/password sign in is enabled you will have one or more  
tabs of information you can modify.

4. When you’re done, click OK.

The above procedure is how a therapist can modify his or her own password.

For the Administrator to modify a therapist’s properties,

1. Sign in as the Administrator.

2. Select Modify Therapist from the Therapist menu. The Select Therapist dialog will be 
displayed. Select the desired therapist and click OK.

3. Depending on whether username/password sign in is enabled you will have one or more  
tabs of information you can modify.

4. When you’re done, click OK.

 
Figure 54d. Therapist Selection dialog
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Deleting a therapist

Only the Administrator can delete therapists. A therapist cannot even delete himself or herself. Be aware 
that when a therapist is deleted, his or her bookmarks, custom cards and all the therapist’s saved routines 
will be deleted. The therapist’s patients will be reassigned to the Administrator rather than be deleted.

To delete a therapist

1. Sign in as the Administrator.

2. Select Delete Therapist from the Therapist menu.

3. The Select Therapist dialog will be displayed. Select the therapist you want to delete  
and click OK.

4. A warning dialog will appear. If you’re sure you want to continue, click Yes. 

5. You will get one more warning before the therapist is permanently deleted.

 
Figure 54e. Remove Therapist warning

Reassigning patients from one therapist to another

Only the Administrator can reassign patients from one therapist to another. While therapists can delete 
their own patients, the Administrator can delete patients belonging to any therapist.

To reassign patients

1. Sign in as the Administrator.

2. Select Reassign Patients from the Patients menu. The Reassign Patients dialog will appear.
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Figure 55. The Reassign Patients dialog

3. Select the therapist to whom you want to reassign patients in the To Therapist drop-down list.

4. Select the therapist who currently owns the patient to be reassigned in the From Therapist 
drop-down list.

5. Select the patient you want to reassign in the patient list.

6. Click Reassign to reassign the selected patient.

7. You will be presented with a warning dialog. If you’re sure you want to do the reassignment, 
click Yes.
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MALE AND FEMALE IMAGES

Several of the kits have exercises in both male and female versions. When a collection has this option, a 
Change Gender Button will appear in the toolbar at the bottom of the exercise browser.

GENDER SELECTION BUTTON

Figure 56a. Gender selection button on exercise browser 

Clicking on this button will allow you to select which gender of exercises you are viewing in the exercise 
browser. When you places exercises into your routine, the currently displayed gender will be used.

NOTE: This gender selection button only affects the exercise browser and new cards you place into the routine. 
It does not change the gender of cards already in the routine. 

To change the gender of a card already in a routine

1. Double-click on the card to bring up the Edit Exercise dialog.

2. In the lower right hand corner of the Edit Exercise dialog will be the gender change button. 
NOTE: This button is only available for exercises taken from kits which have the dual gender feature.

Figure 56b. Gender selection button on Edit Exercise dialog

GENDER SELECTION BUTTON

 

Genders and Custom Cards

For purposes of Custom Cards, the male and female versions of an exercise are treated as different cards. 
When a custom card is created for one gender, it will not appear in the drop-down list of custom cards 
while the other gender exercise is showing. To see the custom cards of the other gender, switch the card to 
the other gender as described above.

NOTE: If you want to have the same custom card for both genders, you will need to create a custom card 
separately for each.
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SUGGESTED ROUTINES AND TIP SHEETS

Many of the kits contain suggested routine or tip sheets. These sheets contain further patient education 
information or sample routines useful for use with the kit. (NOTE: Not all of the kits contain suggested 
routines.) You can access this additional information one of two ways:

• In the Routines menu choose Browse Suggested Routines. See Figure 57a.

Figure 57a. Browse Suggested Routines

• In the Kits menu, highlight the desired kit. A popup menu will be presented from which you 
can choose Suggested Routines. See Figure 57b.

Figure 57b. Suggested Routines in the Kits menu

The suggested routine browser works much like the patient history or saved routine browsers. To the left side 
is presented a list of the available suggested routines. The right side shows the currently selected routine.
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Figure 57c. The Suggested Routine browser

The Sections drop-down list is used to select the desired set of suggested routines or tip sheets. For some 
sections, multiple languages and dual genders will be available. To select which gender or language you wish 
to view, use the Language drop-down list and the gender selection button on the bottom of the suggested 
routine browser.

 
Figure 57d. Language and Gender selection

NOTE: Each routine has been preformatted to fit best into a certain layout. You can change the layout of a 
suggested routine at any time, but it may not look as nice as if the pre-determined layout is being used.
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COPYING ANY EXERCISE TO ANOTHER DOCUMENT

You can copy images from VHI PC-Kits to place into other documents such as those you are creating in 
Microsoft Word.

To copy an image to the clipboard

1. Select the exercise by right-clicking on it in either the exercise browser or routine window.

2. From the context-sensitive menu that appears, select Copy or Copy to Clipboard.

3. Go to the program in which you want to place the exercise.

4. In most programs you’ll need to select Paste Special from the Edit menu. Select that you 
want to paste a picture or bitmap. What’s available and what you select will vary from program 
to program.

Keep in mind these images are copyrighted and permission to redistribute them for a purpose other than 
patient routines may be required.

There is also a Copy Image to Clipboard option in VHI PC-Kits. This will copy the image as a Windows 
Metafile. Not all software can accept this image format, but it will be of higher quality if your software 
can accept it.
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E-MAILING ROUTINES AND TRACKING GRIDS

Exercise Routines and Tracking Grids can be e-mailed as a PDF file to your patients. Your patients must have 
a PDF viewer in order to open the file. In case they do not, the e-mail sent by VHI PC-Kits contains a link 
they can use to obtain a free viewer. Most people already have PDF viewers installed on their machines.

VHI PC-Kits can be configured on a therapist-by-therapist basis to use either the current Windows e-mail 
settings and installed e-mail software, or to use SMTP directly from PC-Kits.

When using your current windows settings, the following e-mail clients are supported,

• Microsoft Outlook and Outlook Express

• Hotmail and Yahoo (with downloadable MAPI provider)

• Eudora (with MAPI provider)

• AOL 7.0 or later (with optional MAPI provider)

Alternatively, each therapist can be configured to send e-mail through an SMTP server, directly from VHI 
PC-Kits. For more information on configuring therapist e-mail options, see the section titled Configuring 
Therapist E-Mail.

For more information on configuring your e-mail client, see your client’s documentation or call VHI Product 
Support. However, we can provide only limited assistance configuring your specific e-mail client.

To e-mail a routine

1. Select Sent To… from either 
the main menu’s, File menu 
or from the menu produced 
by right-clicking the routine.

2. After selecting Send To…, 
select Mail Recipient.  
The Exporting Options  
dialog will appear.

Figure 58a. Exporting Options dialog
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3. Just as when you print the routine, select the 
types of printouts you wish to e-mail to your 
patient and any options you would like.

4. Click OK and the E-Mail Routine dialog will 
appear.

Figure 58b. E-Mail Routine dialog

5. In the E-Mail Routine dialog you can choose 
a patient’s e-mail address or decide to supply 
your own. Patients for whom you have not 
recorded an e-mail address will not be listed.

6. After supplying the desired information, click 
OK. Whatever e-mail client you have installed 
on your machine will appear to send the e-
mail. You can use it to modify the message any 
way you like.

Disabling the E-mail feature

If you are in an environment where you don’t want your therapists e-mail patients directly or if the ability 
to e-mail non-encrypted routines violates your HIPAA policies, then the Administrator can disable the 
ability E-mail.

In the desktop version this is done through the Settings item in the File menu. In the network version this 
is done through Configure Client Parameters in the license manager’s File menu on your license server.
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Exporting exercise routines as PDF files

In addition to being able to e-mail an exercise routine, tracking grid or chart copy, you can also simply export 
them as PDF files. This may be useful if you want to manually attach the routine to an e-mail message or 
if you want to store them in a document archiving and retrieval system.

To export a routine

1. Select Export from the File menu. The Export Routine dialog will appear.

2. Just as when you print the routine, select the types of printouts you wish to export and any 
options you would like.

Figure 59. Export Routine dialog

3. When you’re done, click OK and the Save As… dialog will appear.

4. Name the file and select the desired folder.

5. Click OK and the routine will be exported to the specified file.



66 | PC-Kits Manual

CONFIGURING THERAPIST E-MAIL

By default, therapists in VHI PC-Kits are configured to send e-mail via their existing Windows e-mail 
configuration (MAPI). Such e-mail will be sent using the existing e-mail client software installed on the 
system. A complete list of supported client software is given in the section titled E-Mailing Routines and 
Tracking Grids.

If your e-mail client is not supported by VHI PC-Kits, you may alternatively configure the therapists to 
send e-mail directly from PC-Kits through an SMTP server.

To configure a therapist to use an SMTP server

1. Sign into VHI PC-Kits as the Administrator or as the therapist you want to configure.

2. From the Therapists menu, choose Modify Therapist. If you’re signed into PC-Kits as the 
Administrator, you’ll need to choose the therapist you want to modify.

3. In the Therapist Properties dialog, click on the Email Settings tab.

 
Figure 60. Therapist Email Settings dialog

4. Change the Therapist Email Settings to Send e-mail using the following SMTP server.

5. Supply the full name of the SMTP server (for example, “mail.mycompany.com”).

6. If your SMTP server requires authentication, you’ll need to supply a username and password.
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PURGING PATIENT HISTORIES

VHI PC-Kits allows you to purge the stored histories of your patients. This doesn’t delete the patient, but 
rather deletes the routines that have been saved for the patient. This cannot be done on a patient-by-patient 
basis but is a system wide purging of old patient routines. Therefore, only the Administrator is allowed to 
perform this operation.

To purge patient routines

1. Sign in as the Administrator.

2. From the Patients menu select Browse Patient Histories. This takes you into the patient 
history section of the program.

3. From the Patients menu select Purge Patient Histories… . The Purge Patient Histories 
dialog will appear.

Figure 61a. Purge Patient Histories dialog

4. You can choose to purge all patient history (that is delete all routines saved in patient histories) 
or just those routines saved before a specified date.

5. After making your selection and optionally entering a date, click the OK button.

6. A warning will appear to make sure you really want to delete the routines. You cannot undo 
this deletion.
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DELETING MULTIPLE PATIENTS

Multiple patients can be deleted at once using the Delete patients… item in the Patients menu. The 
patients to be deleted can be manually selected or can be selected based on the date of their last activity. 
Each therapist can delete their own patients, but only the Administrator can delete other therapist’s patients 
or delete patients system wide.

For a therapist to delete multiple of his or her own patients

1. From the Patients menu, select Delete Patients. The Delete Patients dialog will appear.

Figure 61b. Delete Patients dialog

2. To delete individual patients, hold down the control key while clicking on each patient to be deleted. 

OR

3. To delete patients based on date, click on Include Only Patients without activity since and 
fill in a date. Click Apply and the patient list will be updated with just those patients. Select 
the ones you want to delete or press Select All.

4. You will be prompted to make sure you want to perform the deletion.

 
Figure 61c. Delete Patients warning
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DEACTIVATING PATIENTS

Rather than deleting patients, a therapist can simply deactivate them. A deactivated is not removed from 
the database but rather is made to not show up in lists of patients. By deactivating a patient it can be made 
invisible to the user, while preserving the patient’s information and history.

A therapist can deactivate his or her own patients, but only the Administrator can deactivate other therapist’s 
patients or deactivate patients system wide. Once deactivated, a patient can be reactivated at any time.

To deactivate a patient or patients

1. Go into patient histories by selecting Browse Patient Histories from the Patients menu.

2. From the Patients menu select Deactivate/Reactivate Patients.

3. The Deactivate Patients dialog will appear and show all your active patients. If you’re the 
Administrator, then you can display all patients in the system by clicking on Include Patients 
from all Therapists.

Figure 62a. The Deactivate Patient dialog box

4. If you want to deactivate only patients that have been unused for a period of time, then check 
the Include only patients without activity since box. Entering a date and clicking Apply will 
cause the list of patients to be trimmed to those that have been unused since the date specified.
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Figure 62b. Selecting patients based on date

5. Select the patients you want to deactivate or use the Select All to select all  
the patients listed.

6. Once you have selected the patients to be deactivated, click on the  
Deactivate button.

To reactivate inactive patients

1. Follow steps 1 through 3 for deactivating patients.

2. Click on the Include Inactive Patients box to show the currently  
deactivated patients.

3. Select the patients you want to reactivate and click Reactivate.
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GENERATE ROUTINE

This feature is designed to make it easy for staff other than the therapist to create exercise routines for 
patients. The therapist can list by number the exercises that should be on a routine. Assistants can then 
make the routines based on this list of exercise numbers.

To use this feature, you must print a visual index for each of the kits that the therapist may be using. The 
visual index is a printout that shows a thumbnail image of all the exercises in the kit, along with their 
associated numbers.

To print the visual index for a kit

1. From the Kits menu, select the desired kit. A popup menu will appear to the side for the kit.

Figure 63a. Menu item to print the Visual Index

2. Select Print Visual Index from the popup menu. Printing the visual index will take a little 
bit of time due to the large number of exercises on each page. NOTE: Exercise numbers on the 
visual index are not necessarily sequential.

Figure 63b. Part of a sample Visual Index

A therapist then uses the numbers from the visual index to tell an assistant which exercises to put on a 
routine. VHI PC-Kits has the ability to print a form which can be used by the therapist to record this 
information for the assistant.
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To print the routine generation form

1. From the Routines menu choose Generate Routine.

2. When the Generate Routine dialog appears, click the Print Form button.

3. Cancel the Generate Routine dialog.

After the therapist has given the assistant the list of exercises for the routine, the assistant can generate a 
routine using just those exercise numbers.

To generate a routine

1. From the Routines menu choose Generate Routine.

2. When the Generate Routine dialog appears, select Create Routine.

3. In the box next to Create Routine, type in all the exercise numbers, separated by spaces or 
commas.

4. When you’ve entered all the exercise numbers, click OK.

If you want to use a specific layout or language for the routine, be sure to select those first before going into 
the Generate Routine dialog. NOTE: If you are generating a routine for which you’re going to take exercises 
from multiple kits, you must exit the Generate Routine dialog and select the desired kit for each set of exercise 
numbers.

The Generate Routine dialog can also be used to locate an exercise. That is, you can use the Find Exercise 
selection to move the exercise browser to the exercise number specified.
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CREATING YOUR OWN EXERCISES

You can add new exercises to VHI PC-Kits. These exercises can be line drawings (as are used in the kits 
you purchase) or they can be photographs that have been scanned or taken with a digital camera.

Here are a few things to note about adding exercises:

• Added exercises are visible to all therapists. Each therapist cannot add his or her own exercises. 
As such, only the Administrator is allowed to add exercises.

• All new exercises are stored in a kit called User Created Cards. This kit is available in the 
Kits menu.

• Line drawings are smaller and hence faster to use with PC-Kits. For best performance, 
photographs should be resized to a reasonable size before importing. If you’re using a digital 
camera, we recommend the lowest resolution setting for best performance.

• The image files can be of any of the following types: .bmp, .dib, .jpg, .jpeg, .png, .wmf, .pcx, 
.pld, or .gif.

To add an exercise card from a file

1. Sign in as the Administrator.

2. From the Cards menu select Add User Created Card. The User Created Card Properties 
dialog will appear.

Figure 64a. User Created Card Properties dialog
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3. Double-click on the words Double-click here to import image.

4. A copyright warning will appear. Please verify that you are not violating  
copyright laws and then click OK.

5. The Open dialog will appear. Navigate to the image file you want to  
use and double-click it.

Figure 64b. Open dialog

6. The Image Type dialog will appear. In this dialog you must specify whether you’re importing 
a line drawing or a photograph. If you don’t know, choose photograph and click OK.

7. Once the image has appeared, click on the Edit Text tab. In this tab you’ll need to specify:

• Short Title - Consider carefully when deciding on a title for this card because 
the User Created Cards appear in alphabetical order by this first title when the 
exercises are viewed by title.

• Long Title – This title is optional. The title entered in this box is the title that 
will appear on the card itself when you print it.

• Caption – This is also optional, but highly recommended. What you type here 
will appear on the card as the instructions to the patient.

8. After supplying all the desired text, you can preview what the card will look like by clicking on 
the Preview tab.

9. When you’re happy with the image and the text, click Save at the bottom of the User Created 
Card Properties dialog.



PC-Kits Manual | 75

Accessing your exercises

As stated above, all cards added by the user are accessible by every therapist using VHI PC-Kits. Therapists 
cannot create their own private cards. The user cards are stored in a kit called User Created Cards and 
are accessible through the Kits menu just like any other kit.

To access your user created cards

1. From the Kits menu, choose User Created Cards. You can also find this option under the 
Cards menu.

2. Use the cards as you would cards from any other kit. You can bookmark them, saved 
customized versions, edit them, etc.

Modifying User Created Cards

You can modify existing user created cards and either replace the image or modify the text.

To modify an existing User Created Card

1. Sign in as the Administrator.

2. View the user created cards by selecting User Created Cards from the Kits menu.

3. Click on the card to be modified in the exercise browser.

4. From the Cards menu, select Modify User Created Card. The User Created Card 
Properties dialog will appear.

5. Double-click the image to replace it with a different one, or use the Edit Text  
tab to modify the title and description.

6. Click Save when you’re done. Pressing Cancel will discard your changes.

NOTE: Replacing the image on an existing User Created Card will have the following effects:

• All bookmarks associated with the old card will be deleted.

• All customized versions of the old card will be deleted.

• The old version of the card will continue to appear in saved routines and patient history 
routines in which it was used. The patient history is part of a permanent record and hence 
changes to cards are not propagated to them.
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Deleting User Created Cards

Only the Administrator can delete user created cards. Deleting a user created card has the following 
effects:

• The deleted card will continue to exist in any saved routines or  
patient history routines.

• All bookmarks associated with the card will be deleted.

• All customized versions of the card will also be deleted.

To delete a User Created Card

1. Sign in as the Administrator.

2. View the user created cards by selecting User Created Cards from the Kits menu.

3. Click on the card to be deleted in the exercise browser.

4. From the Cards menu select Delete User Created Card.
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ADDING LOGOS

Your company, business or personal logo can be added to the header of routines created by PC-Kits.

Here are a few things to note about logos:

• You can import multiple color or black and white logos and select which logo to use at the 
time you print a routine. 

• You can select a logo as your default logo that will automatically appear on printouts unless 
changed at the time of printing.

• All logos are visible to all therapists. As such, only the Administrator is allowed to add logos 
to the program.

• The image files can be of any of the following types: .bmp, .dib, .jpg, .jpeg, .png, .wmf, 
.pcx, .pld, or .gif.

To import a logo from a file

1. Sign in as the Administrator.

2. From the File menu select Logos and then Add Logo. The Logo Properties dialog will appear.

Figure 70. Logo Properties dialog
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3. Double-click on the words Double-click here to import logo.

4. The Open dialog will appear. Navigate to the image file you want to use and double-click it.

Figure 71. Open dialog

5. Once the image has appeared, click on the General tab. In this tab you’ll need to specify:

• Title – Give the logo a name. This name will be how you select a logo when 
printing.

• Description – This is optional. You can give the logo a description if you want to 
further describe the logo for future reference.

• Default – If you want this logo to be used on printouts by default, put a check 
mark in the Default Logo box.

6. After supplying all the desired information, click OK to save the logo.

After a logo has been created, you can modify the logo at any time.

To modify an existing logo

1. Sign in as Administrator.

2. From the File menu select Logo and then View Logos.

3. Click on the name of the logo that you wish to modify.
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4. To delete the logo, press the Delete button. To modify the logo, press the Modify button.

5. The Logo Properties dialog will be displayed. Follow the same procedure as you did when 
adding the logo to make any desired changes.

Formatting the printing of logos

By default, all logos are be printed in the header at the left side of the page and are printed as 1” x 1”. You 
can change the size and placement of the logo using the Format tab in the Logo Properties dialog.

Figure 72. Format tab of the Logo Properties

The following settings are available:

• Units – This indicates what units are used for the width and height settings. By default, Inches 
is selected. Thus the width and height that you specify must be in inches.

• Width and Height – This is the width of the area that will be used by the logo. Similarly, 
Height is the height of the area to be used by the logo. The logo will be stretched or shrunken 
in both directions until it fits into the specified area.
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• Justification – If the logo does not use up the entire width and height specified, it will be left or 
right justified in that area. You can also top or bottom justify logos that are wider than they are 
tall. Or you can have the logo stretched in both directions to fill the entire area.

• Placement – You can choose to have your logo placed on the left or right hand side of the page. 
Most of the time, placing the logo is the best choice.

It is recommended that you specify a height for the logo based on how large you want it to appear on the 
printout. Then specify a width based on the width of the logo at that size plus any margin you want between 
the logo and the other header text. For most purposes, keeping the justification at Left is the best option. 
However, the settings presented allow for a great variety of logo sizing options.
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ENABLING PASSWORD PROTECTION

By default, VHI PC-Kits allows therapists to sign in by simply selecting their name from a drop-down list. 
This is convenient for a small office setting where just a few people have access to the software.

For larger installation, or for installations where security is a concern, VHI PC-Kits allows therapists to be 
password protected. In this configuration, each therapist is assigned a username and password. The therapist 
then uses this username and password to sign in to the program.

To turn on password protection, use the Security tab of the Program Settings dialog. The Program 
Settings dialog is available through the File menu. On the network version, this tab is available through 
the license manager, running on the license server.

Figure 73. Therapist Sign In settings

To enable password protection

1. Choose the option labeled Password Protect Therapists.

2. If you want therapists to be able to sign in using just a username and a blank password, then 
click on Allow Blank Passwords.

3. Click OK to exit from the Program Settings dialog.

After turning on password protection, the Administrator can sign in to PC-Kits using the username 
“Administrator”. By default, the Administrator has a blank password. You should change the Administrator 
password immediately by using Modify Therapist from the Therapists menu. If you forget your 
administrator password, VHI Product Support can help you recover it. 
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Creating therapists with passwords enabled

Once password protection is enabled, only the Administrator can create new therapists. When creating a 
therapist a username and password will need to be assigned as well as entering the therapist’s name. The 
username must be unique. The therapist can change his or her own password at any time using the Modify 
Therapist menu item in the Therapists menu.

To create a therapist

1. Sign in as the Administrator. 
Remember, by default the 
Administrator username 
is “Administrator” and the 
password is blank.

2. From the Therapists menu 
select Create Therapist.

3. In the General tab supply the 
therapists name and optionally 
his or her e-mail address.

4. In the Sign In tab give the 
therapist a username and 
password. If blank passwords 
are enabled, assigning the 
new therapist a password is 
optional.

Figure 74. Sign In tab in Therapist Properties

 Again, individual therapists can change 
their password by using Modify Therapist 
from the Therapists menu.

Figure 75. Modify Therapist menu item
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Therapist Sign In with passwords enabled

When passwords are enabled, a therapist must use their username and password to gain access to VHI 
PC-Kits. When the program is first started, the Therapist Sign In dialog will appear.

 
Figure 76. Therapist Sign In dialog

To sign in to VHI PC-Kits

1. Type your username in the space provided.

2. If you’re not using a blank password, type your password in the space provided.  
The password will not be displayed as you type it.

3. Click OK to sign in.

4. When you’re done using VHI PC-Kits, be sure to remember to sign out.  
To sign out, press the Sign Out button or exit the program as you normally would.

5. After signing out, the Therapist Sign In dialog will appear to allow another therapist to sign in.

Figure 77. Sign Out button

CURRENTLY SIGNED IN THERAPIST

THERAPIST SIGN OUT BUTTON

For more information or assistance with enabling password protection, please contact VHI Product Support 
at support@vhikits.com.
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USING INTEGRATED WINDOWS AUTHENTICATION

By default, VHI PC-Kits allows therapists to sign in by simply selecting their name from a drop-down list. 
This is convenient for a small office setting where just a few people have access to the software.

In enterprise network environments, this has two limitations. First, this provides no security for the therapists’ 
data. Second, a network administrator would have to create a sign in for every user of the program.

VHI PC-Kits can be configured to identify the therapist running the program by their Windows login. 
Thus, when they run VHI PC-Kits it will not ask them to sign in. Rather it knows whom they are by who 
is signed into the workstation they’re using.

To turn on Integrated Windows Authentication, use the Security tab of the Program Settings dialog. The 
Program Settings dialog is available through the File menu. On the network version, this tab is available 
through the license manager, running on the license server.

Figure 80. Therapist Sign In settings

To enable Windows Authentication

1. Choose the option labeled Sign in therapists using Windows Authentication.

2. If you want therapists to create their own accounts in VHI PC-Kits upon their first sign in, 
then check the box labeled Automatically create new therapists.

3. Click OK to exit from the Program Settings dialog.

If you selected to automatically create new therapists, then the first time anyone runs PC-Kits they will 
be asked to specify their first and last name to create an account for them. It’s your job as the network 
administrator to restrict who can use the software by setting appropriate permissions on the database. If a 
user cannot access the database, he will not be allowed to create a sign in.

Alternatively, if you did not select to automatically create new therapists, then the Administrator will have 
to create an account in PC-Kits for each user they want to have access to the program. Upon creating each 
user, the Administrator will need to specify the user’s first and last name, as well as the domain and/or user 
name to be associated with the account.
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The Administrator can modify the links between a therapist sign in and a domain account using the Modify 
Therapist item in the Therapists menu. To sign in as the administrator, you need to run PC-Kits using 
the following command line:

vhi /u administrator /p password

Administrator passwords can be generated in the license manager on the license server. They are specific to 
your installation of PC-Kits and cannot be used between installations. For further assistance in planning 
and configuring VHI PC-Kits for Integrated Authentication, contact VHI Product Support at 
support@vhikits.com.

NOTE: Integrated Authentication is available with NT 4.0, Windows 2000, Windows XP, and Windows 2003 
or later. It is not available in the demo version of VHI PC-Kits or with Windows 95, 98, or ME.
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AUDIT LOG

VHI PC-Kits allows you to create a log of user activity. This feature may be useful in fulfilling your HIPAA 
compliancy requirements. Using PC-Kits you can create a queryable log of user activity and export it to many 
common file formats, including TSV, CSV, HTML and XML. In addition, you can specify that the audit 
log automatically purge after a specified time period, or you can manually purge the log as required.

To enable audit logging

1. Sign into VHI PC-Kits as the Administrator. In the network version, you’ll need to be running 
the License Manager instead.

2. From the File menu, choose Settings or choose Configure Client Parameters  
in the network version.

3. In the Program 
Settings dialog, click 
on the Audit tab.

Figure 81. Audit tab of Program Settings dialog

4. Click on Enable 
Audit Logging for the 
Following Activities.

5. Select which user 
activity you want to log.

NOTE: The more activities you 
select, the faster the audit log will 
grow in size and the more time 
the program may spend logging 
activity. For the network version, 
if you have a slow network (such as 
a dialup connection) this could be 
significant.

6. If you only want to keep the audit activity for a specified number of days, place a check mark 
in Automatically Purge After and specify a number of days (recommended).

 
Figure 82. Specifying a number of days

7. Click OK for the settings to take affect.
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To disable audit logging

1. Sign into VHI PC-Kits as the Administrator. In the network version, you’ll need to be running 
the License Manager instead.

2. From the File menu, choose Settings or choose Configure Client Parameters in the network 
version.

3. In the Program Settings dialog, click on the Audit tab. See Figure 81.

4. Click on Disable Audit 
Logging.

5. Click OK for the settings to take 
affect.

To purge the audit log

1. Sign into VHI PC-Kits as the 
Administrator. In the network 
version, you’ll need to use the 
VHI PC-Kits client program to 
purge the audit log.

2. In the File menu, choose Audit 
Log.

3. Under Audit Log, choose Purge 
Audit Log.

Figure 83. The Purge Audit Log menu item

4. The Purge Audit Log dialog 
will be displayed.

Figure 84. The Purge Audit Log dialog

5. From here, specify whether you want to 
delete all audit log entries, or only those 
before a certain date.

6. Click Purge.
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To view the audit log

1. Sign into VHI PC-Kits as the Administrator. In the network version, you’ll need to use the 
VHI PC-Kits client program to view the audit log.

2. In the File menu, choose Audit 
Log.

3. Under Audit Log, choose  
View/Export Audit Log.

4. The View Audit Log dialog will 
be displayed.

Figure 85. The View Audit Log dialog

5. Specify the type of audit log 
entries you want to look at and 
then hit the query button. For 
example, if you want to see 
everything done by therapist 
“Diane Akana”, place a 
checkmark in the Show only 
actions carried out by box 
and select the therapist “Diane 
Akana” from the list.

Figure 86. Example of forming an Audit Log query

6. Press the Query  
button.

To export entries from the audit log,

1. Sign into VHI PC-Kits as the Administrator. In the network version, you’ll need to use the 
VHI PC-Kits client program to export entries from the audit log.

2. In the File menu, choose Audit Log.

3. Under Audit Log, choose View/Export Audit Log.
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4. The View Audit Log dialog will be 
displayed. See Figure 85.

5. Specify the type of audit log entries you 
want to export and press the Query 
button to find them.

6. Press the Export button and the Export 
Audit Log dialog will be displayed.

Figure 87. Export Audit Log dialog.

7. Select the format you want to use for the exported entries. The following formats are available:

• TSV - Tab separated values. Each field is separated by a tab (useful for importation into 
Microsoft Excel).

• CSV - Comma separated values. Each field is separated by commas and enclosed in quo-
tations.

• XML - Extensible Markup Language. A tag delimited file useful for importation into 
databases and report writers.

• HTML - Hypertext Markup Language. Useful for generating a human readable file.

8. Click OK and specify a file name in the Save As dialog which appears.

General recommendations for the Audit Log

• The more activities you select, the faster the audit log will grow in size and the more time the 
program may spend logging activity. For the network version, if you have a slow network (such 
as a dialup connection) this could be significant.

• Exporting and purging the audit log on a regular basis will allow you to archive the 
information, while not growing audit files to large sizes.

• When running queries against the audit log, be as specific as possible. Otherwise it might be 
difficult to navigate through the thousands of entries it might contain. Exporting the audit log 
and processing it in a spreadsheet is often useful.

• The audit log provided in PC-Kits should not take the place of proper network and operating 
system auditing and security policies.
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PROGRAM SETTINGS

Certain features of VHI PC-Kits can be customized for your needs. The Program Settings Dialog presents 
these options on six different tabs and allows you to modify them. This section of the manual summarizes 
the meanings of the various settings. For a more detailed discussion, see the help topic presented when 
clicking Help from the Program Settings dialog.

Figure 90. Program Settings

Some of the tabs shown in Figure 90 are only available to the Administrator. Therefore, if a user is not 
signed in as the Administrator, the set of tabs they see might be different.

NOTE: Except where specifically stated, changing a setting will not take effect until the OK button is pressed. 
Pressing CANCEL will discard your changes.

General Settings

• Use Friendly Name Ordering - This setting dictates how therapist and patient names appear 
when printed on routines and clinic cards. If this option is checked, then names will appear 
first name, middle initial, then last on printouts. If this option is not checked, names will be 
printed with the last name first, then first name, then middle initial. 

• Show All Patients - By default, when a therapist browses his or her Patient Histories, all 
patients are shown in the patient list. If there are hundreds of patients being stored in VHI 
PC-Kits, then this list will take a long time to initially populate. Hence, switching into Patient 
Histories could take a significant amount of time.

 If this is the case, turn off the Show All Patients preference. This causes the patient list to be 
initially empty when browsing patient histories. When you start typing a name, the patient list 
will be populated according to the characters you type. 
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• Show Account Number - When this option is checked, the patient’s Account Number (as 
entered when creating the patient) will appear where ever the patient’s name appears. This 
applies to both patient lists within the program, as well as on routine headers and other items 
you print.

• MM-DD-YYYY: Dates shown both in the program and on printed copies will be shown in 
MM-DD-YYYY format. For example, May 23rd, 1969 will be displayed or printed as 05-23-
1969. 

 • DD-MM-YYYY: Dates shown both in the program and on printed copies will be shown 
in DD-MM-YYYY format. For example, May 23rd, 1969 will be display or printed as 23-
05-1969. NOTE: Day and month have been reversed from the standard date format used in the 
United States. This alternate date format is used in Europe.

 • DD MM YYYY: Dates shown both in the program and on printed copies will be shown in 
DD MMM YYYY format. For example, May 23rd, 1969 will be displayed or printed as 23 
May 1969. Only three letters will be used for the name of the month. 

 • MMM DD, YYYY: Dates shown both in the program and on printed copies will be shown in 
MMM DD, YYYY format. For example, May 23rd 1969 will be display or printed as May 23, 
1969. Only three letters will be used for the name of the month.

• Show Current Exercise - There are multiple ways of browsing through the exercises in a kit. 
You can view them 1 at a time, 4 at a time, 9 at a time, or by title only. When viewing by title 
only, this setting controls whether the image for the selected exercise is displayed in a window 
below the list of exercises. 

• Show List in Language - When viewing exercises by title only, the exercise titles appear in 
the default language of the kit (English for U.S., Canada, and Australia) regardless of which 
language you have selected for the exercise cards If you also want to see the exercise title list in 
the selected language, place a check mark in this preference. 

• Start Maximized - This preference determines the size of the program on the video display 
when it is run in Windows. If this option is checked, then VHI PC-Kits will always start 
full-screen. You can change the size of it after it is running, but, the new size will not be 
remembered upon exit, and VHI PC-Kits will again start full screen next time it is run. 

• Print Therapist Name - When a routine is printed for a patient, the name of the therapist 
who created the routine is printed in the header of the routine. Removing the check from this 
preference will prevent the therapist name from printing in the headers of routines. 

 • Default Layout - When you print a routine you can have 1, 2, 3 (split layout), 4, 6, 9, or 12 
exercises per page. This setting allows you to choose what layout you would like VHI PC-Kits 
to use as default, or you can choose to have VHI PC-Kits always default to the last used layout.
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Advanced Settings

• Print After Saving - When this setting is turned on VHI PC-Kits will always bring up the 
Printing Options Dialog after you have saved your routine. 

• This setting causes the card titles to be removed from the cards when they are placed on an 
exercise routine. When this preference is checked, cards will appear and be printed without 
their titles. Cards already placed in saved routines are not affected by this setting.

• Clear After Printing - When this setting is turned on VHI PC-Kits will automatically clear the 
routine after you print it and you will not be given a chance to save it. 

• Clear After Saving - When this setting is turned on VHI PC-Kits will automatically clear the 
routine after you save it. 

• Title Settings - These settings tell VHI PC-Kits how to refer to the Therapists and Patients 
who are using the program. All the menus, dialog boxes, and popup messages in the program 
will refer to the Therapists and Patients by these titles. NOTE: You will need to exit and 
restart VHI PC-Kits in order for this feature to take effect. 

• Professional Title - This is the profession of the person who is signing in to VHI PC-Kits 
and creating the exercise routines. Your choices are: Chiropractor, Coach, Doctor, Instructor, 
Physiologist, Therapist, and Trainer. 

• Client Title - This is the type of person who the routines are being created for. Your choices 
are: Athlete, Client, Patient, Employee, and Student.

Export Settings

The settings on this tab are used to configure options for exporting routines to PDF files.

• Thicken Lines in PDF - When exporting a routine to a PDF file, this setting causes the lines in 
the exercise images to be thickened. This is useful when the PDF is to be displayed very small 
as is the case in some electronic documentation systems.

• Export File Naming - This allows you to specify a default naming convention for patient 
routine’s being exported to PDF files. By default, the therapist performing the export must 
supply a name for the exported PDF file. Alternatively you can choose one of the naming 
conventions presented on this dialog.

• Custom Export File Naming - Custom formats for exported PDF file names are specified here. 
This can be any letters, numbers or symbols that are allowed in Windows for file names. In 
addition, you can embed “%p” for the patient name, “%t” for the therapist name, and “%d” 
for the date.
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Office Settings

The information you fill in here will be used in the Office Card located in the Special Cards section of 
each kit. The Office Card allows you to include specific information about your business in a routine. This 
information is optional and you may leave it blank. VHI PC-Kits does not impose any format or restrictions 
(other than length) on the information you provide.

Security Settings

If you are running the network version of VHI PC-Kits these options are not configurable from the client. 
Instead, you will need to modify them from the VHI License Manager. In the desktop version only the 
Administrator is allowed to modify these settings.

• Separate Data By Therapist - By default, VHI PC-Kits separates patient and other information 
by therapist. When a therapist uses the program, the therapist first signs in under his or her 
name. This feature can be turned off. Doing so will cause all data to be saved under the 
Administrator. There will be no sign in dialogs presented, and the therapist list on the toolbar 
will not be available. 

• Administrator Can Delete Any Data - By default, the Administrator can delete any Patient, 
Saved Routine, etc. from the program regardless of which therapist owns the information. If 
this presents a problem with accidental deletion of information, this feature can be turned off. 
While turned off, only the therapist who owns the data can delete it.

• Disable Email - If you do not have your email properly set up, or you do not want your 
therapists emailing their routines to their patients, you can use this setting to disable the ability 
to email routines.

• Therapist Sign In Preferences - These settings pertain to how the user will sign in to VHI PC-Kits.

• Do Not Password Protect - This setting allows anyone to sign in to VHI PC-Kits under 
whatever account they want. When the program starts up the user selects what therapist they 
would like to sign in as from a drop-down list.

• Password Protect Therapists - This setting requires that anyone signing in to VHI PC-Kits 
has to provide a username and password. The sign in information for each therapist is saved 
in the VHI PC-Kits database and the passwords are encrypted. You can choose to allow blank 
passwords or not. 

• Sign In Therapists Using Windows Authentication - This setting uses the Microsoft Windows 
account that the user logged on to the computer with, to sign in to VHI PC-Kits. No 
usernames or passwords are required because your Microsoft Windows logon signs you in to 
VHI PC-Kits. To sign in to VHI PC-Kits as someone else you will need to log off Microsoft 
Windows and logon to Microsoft Windows under a different account. 
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Audit Settings

These settings are only viewable when signed into PC-Kits as the “Administrator”. If you are running the 
network version, these options are not configurable from the client. Instead you will need to modify them 
from the VHI License Manager. See the section titled Audit Log for more information about using the 
auditing feature.

• Enable Audit Logging - When this is selected, various activities performed by therapists will be 
stored in an audit log. The more types of activities you choose to audit, the faster the audit log 
will grow in size.

• Creating and Deleting Patients - Selecting this option will cause the creation and deletion of 
patients to be logged.

• Viewing and Modifying Patient Properties - Selecting this option will log any access to patient 
account information, both for viewing or changing.

• Viewing, Creating or Modifying Patient Routines - This option will log all viewing or 
modifying of the routines in the patient’s history.

• Therapist Creation and Login Activity - All therapist creation, deletion or sign in activity will 
be recorded.

• Automatically Purge - Use this option to specify how long audit events should be stored in 
the audit log. Since the audit log can grow rapidly, it’s recommended that you specify a time 
period for which audit log entries should be kept. Removing the check mark from this item 
will cause all audit log entries to be kept until manually purged.




